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1 How Do I?
Learn how to use your HP All-in-One
• Printer parts
• Load media
• Replace the cartridges
• Clear a paper jam

How Do I? 3
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2 Get to know the HP All-in-One
• Printer parts
• Control panel features
• Wireless Settings
• Status Lights
• Auto Power-Off

Printer parts
• Front and top views of the HP All-in-One

1 Display

2 Control panel

3 Paper tray

4 Paper tray extender (also referred to as the tray extender)

5 Glass

6 Lid-backing

7 Lid

8 Cartridge door

9 Cartridge access area

10 Cleanout door

Get to know the HP All-in-One 5
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• Rear view of the HP All-in-One

11 Rear USB port

12 Power connection

Control panel features

Figure 2-1 Control panel features

Wireless

ePrint

Copy

Scan

Quick Forms

7

1 Back: Returns to the previous screen.

2 Cancel: Stops the current operation, restores default settings.

3 Setup: Opens the Setup menu where you can check ink levels, change Auto Power-Off setting,
perform maintenance tasks, and set language and region settings.

4 Selection buttons: Use buttons to select menu items on the printer display.

5 Wireless status light and button: Blue light indicates wireless connection. Pressing button
opens wireless menu. Press and hold until light blinks to start WPS push button mode.

6 ePrint light and button: White light indicates ePrint is connected. Pressing button displays
printer's email address and ePrint menu options.

7 On button
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Wireless Settings
Press the Wireless button to view wireless status and menu options.
• If the printer has an active connection to a wireless network, the printer display will

show Connected and the printer’s IP.
• If wireless is disabled (wireless radio off) and the wireless network is not available,

the display screen shows Wireless Off.
• If wireless is enabled (wireless radio on) and you do not have a wireless

connection , the display screen shows that it is either in the process of Connecting or
Not Connected.

You can use the printer display to retrieve information about your wireless network,
establish a wireless connection, and more.

How do I? Instructions

Print network configuration page.
The network configuration page will display the network
status, hostname, network name, and more.

1. Press the Wireless button to
display the Wireless Menu.

2. From the Wireless Menu, select
Print Reports.

3. From the Print Reports menu
select Configuration.

Print wireless network test report.
The wireless network test report will display the
diagnostics results for the status of the wireless network,
wireless signal strength, detected networks, and more.

1. Press the Wireless button to
display the Wireless Menu.

2. From the Wireless Menu, select
Print Reports.

3. From the Print Reports menu
select Wireless Test.

View signal strength of wireless connection. 1. Press the Wireless button to
display the Wireless Menu.

2. From the Wireless Menu, select
Connected IP XXX.XXX.XX.XX.

3. Printer display will show wireless
signal strength.

Restore network settings to default settings. 1. Press the Wireless button to
display the Wireless Menu.

2. From the Wireless Menu, select
Settings.

3. From the Settings menu, select
Restore Defaults.

4. Confirm selection to restore
defaults.

Turn wireless on or off. 1. Press the Wireless button to
display the Wireless Menu.

2. From the Wireless Menu, select
Wireless Settings.

3. From the Settings menu, select
Wireless On/Off.

4. From the Wireless On/Off menu
select On or Off.

Wireless Settings 7
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How do I? Instructions

Establish a Wi-Fi Protected Setup (WPS) connection. WiFi Protected Setup (WPS – requires
WPS router)

Status Lights
• Wireless Status Light
• ePrint Status Light
• On Button Light

Wireless Status Light

Wireless

Light behavior Solution

Off Wireless is off. Press Wireless button
to access wireless menu on the printer
display. Use wireless menu to enable
wireless printing.

Slow blinking Wireless is on but not connected to a
network. If connection cannot be
established, make sure printer is
within range of wireless signal.

Fast blinking Wireless error has occurred. Refer to
messages on printer display.

On Wireless connection has been
established and you can print.

ePrint Status Light

ePrint

Light behavior Solution

Off ePrint is disabled. Press ePrint button
to access ePrint menu on the printer
display.

On ePrint is on and connected.

Chapter 2
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On Button Light

Light behavior Solution

Off The device is powered off.

Pulsing Indicates the device is in sleep mode.
The device automatically enters sleep
mode after 5 minutes of inactivity.

Fast blinking Error has occurred. Refer to messages
on printer display.

On Printer is on and ready to print.

Auto Power-Off
Auto Power-Off is automatically enabled by default when you turn on the printer. When
Auto Power-Off is enabled, the printer automatically turns off after 2 hours of inactivity to
help reduce energy use. Auto Power-Off is automatically disabled when the printer
establishes a wireless or Ethernet (if supported) network connection. You can change the
Auto Power-Off setting from the control panel. Once you change the setting, the printer
maintains the setting. Auto Power-Off turns the printer off completely, so you must use
the power button to turn the printer back on.

To change Auto Power-Off setting
1. From the Control Panel home screen, which displays Copy, Scan, and Quick Forms,

press the Setup button.

NOTE: If you do not see the home screen, press the Back button until you can
see it.

2. From the Setup menu on the printer display, select Auto Power-Off.
3. From the Auto Power-Off menu select Enabled or Disabled, and then confirm the

setting.

TIP: If you are printing over a wireless or Ethernet connected network, Auto Power-
Off should be disabled to ensure that print jobs do not get lost. Even when Auto
Power-Off is disabled, the printer enters Sleep mode after 5 minutes of inactivity to
help reduce energy use.

Auto Power-Off 9
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3 Print
Choose a print job to continue.

Print photos

Print documents

Print envelopes

Print Quick Forms

See Tips for print success for more information.

Print photos

To print a photo on photo paper
1. Pull out the paper tray.
2. Remove all paper from the paper tray, and then load the photo paper with side to be

printed on facing down.

NOTE: If the photo paper you are using has perforated tabs, load photo paper
so that tabs face outward.

See Load media for more information.
3. On the File menu in your software application, click Print.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Print 11
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6. Select the appropriate options.
• On Layout tab select Portrait or Landscape orientation.
• On Paper/Quality tab select the appropriate paper type and print quality from

the Media drop-down list.

NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select
Photo Paper, Best Quality from the Media drop-down list. Then go to the
Advanced tab and select Yes from the Print in Max DPI drop-down list. If you
want to print Max DPI in grayscale, select High Quality Grayscale from Print in
Grayscale on the drop-down list, and then select Max DPI, after selecting Photo
Paper, Best Quality.

7. Click OK to return to the Properties dialog box.
8. Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat
before printing.

Print documents

To print from a software application
1. Make sure the paper tray is open.
2. Make sure you have paper loaded in the paper tray.

See Load media for more information.
3. From your software application, click the Print button.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

6. Select the appropriate options.
• On Layout tab select Portrait or Landscape orientation.
• On Paper/Quality tab select the appropriate paper type and print quality from

the Media drop-down list.

Chapter 3

12 Print

Print

DRA
FT



7. Click OK to close the Properties dialog box.
8. Click Print or OK to begin printing.

NOTE: You can print your document on both sides of the paper, instead of just one
side. Click on the Advanced button on the Paper/Quality or Layout tab. From the
Pages to Print drop-down menu select Print Odd Pages Only. Click OK to print. After
the odd numbered pages of the document have been printed, remove the document
from the output tray. Reload the paper in the input tray with the blank side facing up.
Return to the Pages to Print drop-down menu and then select Print Even Pages Only.
Click OK to print.

NOTE: If your printed documents are not aligned within the margins of the paper,
make sure that you have selected the correct language and region. On the printer
display, select Setup, then select Language/Region. Select your language, and then
region from the options provided. The correct Language/Region settings ensure that
the printer will have the appropriate default paper size settings.

Print Quick Forms
Use Quick Forms to print Office Forms, Paper Types, and Games.

Print Quick Forms
1. Select Quick Forms from the printer display menu.

TIP: If the Quick Forms option does not appear on the printer display menu,
press the Back button until the Quick Forms option appears.

2. Press the selection buttons to select Office Forms, Paper Type, or Games. Then select
OK.

3. After you have selected the type of Selection that you want to print, select the number
of copies, then press OK.

Print envelopes
You can load one or more envelopes into the input tray of the HP All-in-One. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a
label for the return address on envelopes.

To print envelopes
1. Make sure the paper tray is open.
2. Slide the paper guides outward.
3. Place the envelopes in the center of the tray. The side to be printed on should face

down. The flap should be on the left side.
See Load media for more information.

4. Push the envelopes into the printer until they stop.

Print envelopes 13
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5. Slide the paper guides firmly against the edges of the envelopes.

6. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

7. Select the appropriate options.
On Paper/Quality tab select the appropriate paper type and print quality from the
Media drop-down list.

8. Click OK, and then click Print or OK in the Print dialog box.

Tips for print success
To successfully print, the HP cartridges should be functioning properly with sufficient ink,
the paper should be loaded correctly, and the product should have the appropriate
settings.

Ink tips
• Use genuine HP ink cartridges.
• Install the yellow, magenta, cyan, and black cartridges correctly.

For more information, see Replace the cartridges.
• Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

For more information, see Check the estimated ink levels.
• For more information, see Improve print quality.
• If you are seeing ink smears on the back of the pages that you printed, use the Tools

menu to clean.
◦ From the home screen, which displays Copy, Scan, and Quick Forms, press the

Setup button.

NOTE: If you do not see the home screen, press the Back button until you
can see it.

◦ Scroll through the Tools menu until you see Clean Ink Smear, then select OK.
◦ Follow the onscreen instructions.

Paper loading tips
• Load a stack of paper (not just one page). All of the paper in the stack should be the

same size and type to avoid a paper jam.
• Load paper with side to be printed on facing down.
• Ensure that paper loaded in the paper tray lays flat and the edges are not bent or

torn.

Chapter 3
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• Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make
sure the paper-width guide does not bend the paper in the paper tray.

• For more information, see Load media.

Printer settings tips
• On the Paper/Quality tab of the print driver, select the appropriate paper type and

print quality from the Media drop-down list.
• Select the appropriate size from the Paper Size drop-down list on the Paper/Quality

tab.
• Click the HP All-in-One desktop icon to open the Printer Software. In the Printer

Software, click Printer Actions and then click Set Preferences to access the print
driver.

NOTE: You can also access the Printer Software by clicking Start > Programs >
HP > HP Deskjet 3520 series > HP Deskjet 3520 series

Notes
• Genuine HP ink cartridges are designed and tested with HP printers and papers to

help you easily produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product
service or repairs required as a result of using a non-HP supply will not be
covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

• Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not
need to replace the cartridges until print quality becomes unacceptable.

• Software settings selected in the print driver only apply to printing, they do not apply
to copying or scanning.

• You can print your document on both sides of the paper, instead of just one side.

NOTE: Click the Advanced button on the Paper/Quality or Layout tab. From the
Pages to Print drop-down list select Print Odd Pages Only. Click OK to print. After
the odd numbered pages of the document have been printed, remove the
document from the output tray. Reload the paper in the input tray with the blank
side facing up. Return to the Pages to Print drop-down list and then select Print
Even Pages Only. Click OK to print.

• Print using black ink only

NOTE: If you want to print a black and white document using black ink only,
click the Advanced button. From the Print in Grayscale drop-down menu select
Black Ink Only, then click the OK button.

Tips for print success 15
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Print using the maximum dpi
Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo
paper.

See technical specifications for the print resolution of the maximum dpi mode.

Printing in maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.

To print in Maximum dpi mode
1. Make sure you have photo paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Paper/Quality tab.
6. In the Media drop-down list, click Photo Paper, Best Quality.

NOTE: Photo Paper, Best Quality must be selected from the Media drop-down list
on the Paper/Quality tab to enable printing in maximum DPI.

7. Click the Advanced button.
8. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
9. Select Paper Size from Paper/Output drop-down list.
10
.

Click OK to close the advanced options.

11
.

Confirm Orientation on Layout tab, then click OK to print.
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4 ePrint from anywhere
The ePrint feature on your product provides convenience printing that allows you to print
from anywhere. Once enabled, ePrint assigns an email address to your product. To
print, simply send an email containing your document to that address. You can print
images, Word, PowerPoint, and PDF documents. It's easy!
• ePrint from anywhere

ePrint from anywhere

To ePrint a document from anywhere
1. Find your ePrint email address.

a. Press the ePrint button on the control panel. You will see the web services
Settings menu on the printer display.

b. Select Display Email Address from the printer display to view the printer’s email
address.

NOTE: To use ePrint, web services must first be enabled. If web services have
not been enabled, you will see a message directing you to the Printer Software.
Open the Printer Software, select ePrint, then follow the onscreen instruction to
enable.

TIP: To print the email address or registration url, select Print Info Sheet from the
Settings menu on the printer display.

2. Compose and send email.
a. Create a new email and type the product email address in the To box.
b. Type text in the body of the email and attach the documents or images that you

want to print.
c. Send the email.

The product prints your email.

NOTE: To receive email, your product must be connected to the Internet.
Your email will print as soon as it is received. As with any email, there is no
guarantee when or if it will be received. When you register online with
ePrint, you can check the status of your jobs.

TIP: If you have enabled Auto Power-Off, you should disable it before using
ePrint. For more information, see Auto Power-Off

NOTE: Device must be connected wirelessly and on an active network.

NOTE: Documents printed with ePrint may appear different from the original. Style,
formatting, and text flow may differ from the original document. For documents that
need to be printed with a higher quality (such as legal documents), we recommend
that you print from the software application on your computer, where you will have
more control over what your printout looks like.

ePrint from anywhere 17
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 Click here to go online for more information.
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5 Paper basics
• Recommended papers for printing
• Load media

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok
HP recommends plain papers with the ColorLok logo for printing and copying of
everyday documents. All papers with the ColorLok logo are independently tested to meet
high standards of reliability and print quality, and produce documents with crisp, vivid
color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the
ColorLok logo in a variety of weights and sizes from major paper manufacturers.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without smudging.
It resists water, smears, fingerprints, and humidity. Your prints have a look and feel
comparable to a store-processed photo. It is available in several sizes, including A4, 8.5
x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and
two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. It is available in semi-gloss finish
in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or
without tabs). For longer-lasting photos, it is acid-free.

Paper basics 19
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HP Brochure Paper or HP Superior Inkjet Paper
These papers are glossy-coated or matte-coated on both sides for two-sided use. They
are the perfect choice for near-photographic reproductions and business graphics for
report covers, special presentations, brochures, mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper
These papers are heavy two-sided matte papers perfect for presentation, proposals,
reports, and newsletters. They are heavyweight for an impressive look and feel.

HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder
blacks, and vivid colors.

HP Printing Paper
HP Printing Paper is a high-quality multifunction paper. It produces documents that look
and feel more substantial than documents printed on standard multipurpose or copy
paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid
colors. It is acid-free for longer lasting documents.

HP Office Paper
HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts,
memos, and other everyday documents. It features ColorLok Technology for less
smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

HP Iron-On Transfers
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.

HP Premium Inkjet Transparency Film
HP Premium Inkjet Transparency Film make your color presentations vivid and even more
impressive. This film is easy to use and handle and dries quickly without smudging.

HP Photo Value Pack
HP Photo Value Packs conveniently package original HP cartridges and HP Advanced
Photo Paper to save you time and take the guesswork out of printing affordable
professional photos with your HP All-in-One. Original HP inks and HP Advanced Photo
Paper have been designed to work together so your photos are long lasting and vivid,
print after print. Great for printing out an entire vacation’s worth of photos or multiple
prints to share.
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Load media
▲ Select a paper size to continue.

Load full-size paper
a. Lower the paper tray.

❑ Lower the paper tray and pull out the tray extender.

b. Slide paper-width guides outward.
❑ Slide paper-width guides outward.

c. Load paper.
❑ Insert stack of paper into paper tray with short edge forward and print side

down.

Load media 21
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❑ Slide stack of paper until it stops.
❑ Adjust paper-width guides so they fit against both sides of the stack of paper.

Load small-size paper
a. Slide the paper tray out.

❑ Slide the paper tray and pull out the tray extender.

b. Slide paper-width guides outward.
❑ Slide paper-width guides outward.

c. Load paper.
❑ Insert stack of photo paper with short edge down and print side down.
❑ Slide stack of paper forward until it stops.

NOTE: If the photo paper you are using has perforated tabs, load photo
paper so that tabs face outward.

❑ Adjust paper-width guides so they fit against both sides of the stack of paper.
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❑ Slide paper tray in.

Load envelopes
a. Lower the paper tray

❑ Lower the output tray and pull out the tray extender.

b. Slide paper-width guides outward.
❑ Slide paper-width guide outward.

❑ Remove all paper from the main input tray.
c. Load envelopes.

❑ Insert one or more envelopes in center of the input tray. The side to be
printed on should face up. The flap should be on the left side and facing
down.

❑ Slide stack of envelopes down until it stops.
❑ Slide paper-width guide to the right against stack of envelopes until it stops.

Load media 23
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6 Copy and scan
• Copy
• Scan to a computer
• Tips for copy success
• Tips for scan success

Copy
▲ The copy menu on the printer display allows you to easily select number of copies

and color or black and white for copying on plain paper. For more advanced
settings, such as changing the paper type and size, adjusting the darkness of the
copy, and resizing the copy, select Settings from the Copy Menu.
Click a copy type to continue.

Easy Copy
a. Load paper.

❑ Load full-size paper in the paper tray.

b. Load original.
❑ Lift lid on product.

Copy and scan 25
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